Converged Multimedia
User Guide
# Contents

- **New in this release**: 1
  - Features 1
  - Other changes 1
- **Welcome**: 3
  - Audience 3
  - Text conventions 4
  - Acronyms 4
  - Related publications 5
  - How to get help 5
- **Before you start**: 7
  - About Converged desktop service 7
    - Features and services 7
    - Useful terms 9
      - Converged Phone 9
      - Address 9
      - Conference 10
      - Conversation 10
      - Service package 10
      - Friends 13
      - Personal address book 14
      - Global address book 14
      - Presence 15
      - Proxy server 16
      - Call logs 16
      - Routes 17
      - Preferred Audio Device (PAD) 17
  - Getting started 19
    - What is the Multimedia PC Client? 19
    - Configurations 20
      - Multimedia PC Client 21
Contents

MCS Client Set ................................................. 21
Converged Desktop Mode on the MCS Client ............... 21
Features available to Converged Desktop users .......... 22
What you need to begin using the MCS Client .......... 22
Minimum hardware and operating system requirements .... 23
Recommended hardware and operating system requirements . 23
Optional hardware and software requirements ........... 24
Installing the Multimedia PC Client software ............ 24
Launching the Multimedia PC Client .................... 25
Automatically starting the Multimedia PC Client ........ 29
Signing in to the Multimedia PC Client ................. 29
Understanding the Multimedia PC Client interface ....... 33
The Converged desktop service interface ............. 33
Verifying Converged desktop service ................ 33
Main menu actions ........................................... 36
Main buttons .................................................. 37
Status buttons ............................................... 38
System tray icon .............................................. 40
Advanced set-up ............................................. 42
Routing ....................................................... 42
Presence ....................................................... 48
Managing Contacts .......................................... 48
Using online help ........................................... 48
Multimedia communication .................................. 51
Making a call with Converged desktop service ........... 52
Making a call within Microsoft Outlook ................. 53
Manually making a voice or video call with Converged desktop service ................................. 54
Receiving a call ............................................ 58
Sending and receiving video ................................ 59
Answering a video call ................................... 60
Ending a voice or video call ................................ 60
Sharing ....................................................... 62
Understanding sharing ................................... 62
Starting a sharing conversation ......................... 63
Starting a whiteboard, clipboard, and web page sharing operation without a call ............................ 64
## Contents

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Starting a Send File sharing conversation without a call</td>
<td>66</td>
</tr>
<tr>
<td>Ending a sharing conversation</td>
<td>69</td>
</tr>
<tr>
<td>Sending web pages</td>
<td>69</td>
</tr>
<tr>
<td>Pushing a web page to another party on an active call</td>
<td>69</td>
</tr>
<tr>
<td>Pushing a web page to another party not on an active call</td>
<td>70</td>
</tr>
<tr>
<td>Receiving web pages</td>
<td>72</td>
</tr>
<tr>
<td>Transferring files (Sending files)</td>
<td>74</td>
</tr>
<tr>
<td>Sending files</td>
<td>74</td>
</tr>
<tr>
<td>Receiving files</td>
<td>77</td>
</tr>
<tr>
<td>Accessing received files</td>
<td>79</td>
</tr>
<tr>
<td>Sharing a whiteboard</td>
<td>79</td>
</tr>
<tr>
<td>Sending a whiteboard request</td>
<td>80</td>
</tr>
<tr>
<td>Receiving a share whiteboard request</td>
<td>82</td>
</tr>
<tr>
<td>Using the whiteboard</td>
<td>84</td>
</tr>
<tr>
<td>Saving whiteboard drawings</td>
<td>86</td>
</tr>
<tr>
<td>Restoring whiteboard drawings</td>
<td>86</td>
</tr>
<tr>
<td>Transferring the clipboard</td>
<td>86</td>
</tr>
<tr>
<td>Placing content in the Windows clipboard</td>
<td>87</td>
</tr>
<tr>
<td>Sending clipboard data</td>
<td>87</td>
</tr>
<tr>
<td>Receiving a transfer clipboard request</td>
<td>89</td>
</tr>
<tr>
<td>Using or saving the received clipboard data</td>
<td>91</td>
</tr>
<tr>
<td>Making an E911 call</td>
<td>92</td>
</tr>
<tr>
<td>Disabling call waiting</td>
<td>93</td>
</tr>
<tr>
<td>Parking a call</td>
<td>94</td>
</tr>
<tr>
<td>Other services unavailable in the Converged desktop mode</td>
<td>94</td>
</tr>
<tr>
<td>Conference calling</td>
<td>95</td>
</tr>
<tr>
<td>Sending instant messages</td>
<td>96</td>
</tr>
<tr>
<td>Using voice mail</td>
<td>97</td>
</tr>
<tr>
<td>Message Waiting Indicator (MWI)</td>
<td>98</td>
</tr>
<tr>
<td>Accessing your voice mailbox</td>
<td>99</td>
</tr>
<tr>
<td>Setting up SimRing for your desktop phone</td>
<td>99</td>
</tr>
<tr>
<td><strong>Button references</strong></td>
<td>101</td>
</tr>
<tr>
<td>Conversation window – Incoming call buttons</td>
<td>101</td>
</tr>
<tr>
<td>Conversation window – Call control buttons</td>
<td>102</td>
</tr>
<tr>
<td>Conversation window – Voice mail control buttons</td>
<td>103</td>
</tr>
</tbody>
</table>
Contents

Conversation window – Sharing buttons ........................................ 104
Conversation window – Instant Message buttons ................................ 104
Hardware notes .............................................................................. 107

Compatible video cameras ................................................................. 107
Compatibility with the client application ........................................... 108
New in this release

The following sections detail what's new in *Nortel Converged Multimedia User Guide* (NN10426-112) for the MCS09FF release.

Features

There are no new features for the MCS09FF release of the *Nortel Converged Multimedia User Guide*.

Other changes

The following changes for the MCS09FF release of the Converged Multimedia User Guide are not specifically feature-related:

- The name of this document is changed from *Nortel Converged Desktop Getting Started Guide* to *Nortel Multimedia Client User Guide*.
- References in this document have changed due to restructuring of the MCS 5200 document suite.
2. New in this release
Welcome

This guide describes how to set up and start using your Nortel MCS Converged Desktop Service feature.

Topics include:

- About Converged desktop service
- What is the Multimedia PC Client?
- Converged Desktop Mode on the MCS Client
- What you need to begin using the MCS Client
- Understanding the Multimedia PC Client interface
- Multimedia communication

Audience

This guide is intended for users Converged Desktop users of the Multimedia PC Client services and features.

We recommend that you keep your access client open when you follow the steps described in the MCS Client documentation.

Screen captures in the MCS Client documentation show Internet Explorer as the default browser. However, if you are using another browser (for example, Netscape), your screen may look slightly different.
Text conventions

This guide uses the following text conventions:

**bold text**

Indicates the command key or link you need to press or click.

Example: Press **Ok**, Click **Enter**

**italic text**

Indicates new terms, document titles

Example: See the *Personal Agent User Guide*

Acronyms

This guide uses the following acronyms:

- CDU: Converged Desktop User
- DHCP: Dynamic Host Configuration Protocol
- DND: Do Not Disturb
- DTMF: Dual Tone Multi Frequency
- ERC: Express Routing Code
- ISDN: Integrated Services Digital Network
- IM: Instant Message
- IP: Internet Protocol
- IPCM: Internet Protocol Client Manager
- LAN: Local Area Network
- LCD: Liquid Crystal Display
- MAC: Media Access Control
- PA: Personal Agent
- PNG: Portable Network Graphic
- QoS: Quality of Service
- SIP: Session Initiation Protocol
Welcome

Related publications

Other publications related to the *Nortel Converged Multimedia User Guide*:

- *Nortel Personal Agent User Guide* (NN10039-113)
- *Nortel MCS 5200 Feature Overview* (NN10251-115)

How to get help

For service issues, please contact your local support or Information Services team.

<table>
<thead>
<tr>
<th>Abbreviation</th>
<th>Full Form</th>
</tr>
</thead>
<tbody>
<tr>
<td>URL</td>
<td>Universal Resource Locator</td>
</tr>
<tr>
<td>VoIP</td>
<td>Voice over IP</td>
</tr>
<tr>
<td>WAN</td>
<td>Wide Area Network</td>
</tr>
<tr>
<td>PAD</td>
<td>Preferred Audio Device</td>
</tr>
</tbody>
</table>
Welcome
Chapter 1
Before you start

About Converged desktop service

With Session Initiation Protocol (SIP)-based Converged desktop service, your desktop telephone provides premium-quality voice, while your computer is dedicated to the data components of the multimedia session. The Multimedia PC Client with Converged desktop service configuration is a cost-effective solution that allows you to maintain your existing desktop telephone for voice calls, while using the Multimedia PC Client for multimedia communication.

The basic service package does not include the following services: instant messaging, client collaboration (includes file transfer, whiteboard, transfer clipboard, and web push), allowed clients (which allows interaction with i200x phones), or multiple login restriction. These services are individually assigned to you by the administrator.

Features and services

There are various versions of the Converged desktop service. Those versions are:

- SimRing Converged desktop service (type 1) for MCS 5100
  - In this configuration, the Communication Server 1000 (CS 1000) is set to SimRing and the MCS 5100 user is provisioned to use the MCS Client with Converged desktop service supported over Primary Rate Interface (PRI) (DMS 100 switch) or H.323.
- SimRing Converged desktop service (type 1) for MCS 5200
In this configuration, the Communication Server 2000 (CS 2000) is set to SimRing and the MCS 5200 user is provisioned to use the MCS Client with Converged desktop service supported over Primary Rate Interface (PRI) (DMS 100 switch) or H.323.

The SimRing functionality was developed in a previous Multimedia Communication Server (MCS) release. SimRing is a functionality on the existing Time Division Multiplexing (TDM) system that provides simultaneous ringing at multiple endpoints in a termination attempt to a user.

The MCS 3.0 release and above does not support the SimRing Converged desktop service (type 1).

- **SimRing Converged desktop service (type 2) for MCS 5100**
  - In this configuration, the CS 1000 is set to SimRing and the MCS 5100 user is provisioned as a standard user with a MCS Client that is not using Converged desktop service (regular MCS Client). This configuration is supported over PRI (DMS 100 switch) or H.323.

- **SimRing Converged desktop service (type 2) for MCS 5200**
  - In this configuration, the CS 2000 is set to SimRing and the MCS 5200 user is provisioned as a standard user with a MCS Client that is not using Converged desktop service (regular MCS Client). This configuration is supported over PRI (DMS 100 switch) or H.323.

- **Personal Agent-driven Converged desktop service for MCS 5100**
  - This configuration is used between a MCS 5100 and systems that do not support SimRing, such as the Business Communication Manager (BCM) and third-party systems. In this configuration, the inbound call is first directed to the MCS 5100, and the Personal Agent redirects the call to the user’s terminal on the existing switching system.

  **Tip:** This type of user uses the Personal Agent as the only way to access Converged desktop service.

- **Personal Agent-driven Converged desktop service for MCS 5200**
  - This configuration is used between a MCS 5200 and systems that do not support SimRing.

- **SIP-based Converged desktop service for MCS 5100**
  - This configuration is between MCS 5100 and a CS 1000. This version is a MCS 3.0 offering.
Chapter 1 Before you start

- SIP-based Converged desktop service for MCS 5200
  - This configuration is a full feature version of Converged desktop and uses basic Advanced Intelligent Network (AIN) call flows to provide Time Division Multiplex (TDM) voice and multimedia convergence to class 5 lines that support AIN call flows.

**Tip:** This guide focuses on the SIP-based version of the Converged desktop service. The terms *Converged desktop service* and *Converged desktop user* in this guide refer to this version.

For detailed information about Converged desktop service and its capabilities, refer to *Nortel MCS 5200 Feature Overview* (NN10251-115).

**Useful terms**

The Converged Desktop services are part of an integrated multimedia communications system. Here are a few terms you need to be familiar with before you begin using these services.

**Converged Phone**

The user’s desktop phone that has been assigned by the system administrator to be associated with the user’s Converged Desktop service.

**Address**

When a procedure instructs you to enter an address it means entering either a telephone number or a SIP address. A SIP address is a unique identifier of users on the IP network. It has the same format as an email address, for example, jdoe@lab1.org, but it is not an email address. The network can identify where you are and route your calls by tracking your SIP address when you sign in to any Multimedia PC Client, Multimedia Web Client, or i2002 or i2004 Internet Telephone. In order to make it easier to place calls, you can store addresses (SIP addresses or telephone numbers) in a personal address book.

Using SIP addresses allows you to take advantage of the more powerful features of the Multimedia PC Client, such as presence.
Conferences

Conferences are calls that involve more than two callers. The two types of conferences are ad hoc and meet me. Ad hoc conferences are conferences that are created on the fly by joining multiple calls together into one conference call. Meet me conferences are conferences that use a pre-defined conference number where users provide an access number (and optionally a passcode) to be placed into the appropriate conference bridge. The network conference server is responsible for hosting both types of conferences. The Multimedia PC Client can be used to create Ad hoc audio conferences, or to dial into Meet me audio conferences.

The conferencing procedures in this guide refer only to Ad hoc audio conferences. For more information about Meet me audio conferences, refer to Nortel MCS 5200 Feature Overview (NN10251-115) and to the online help available in the MCS Meet Me Web Collaboration service.

Conversations

The Multimedia PC Client allows you to converse with another user in a multitude of ways. Conversations can involve one or more multimedia functionalities. For example, a conversation may involve just voice (voice conversation), or just instant messaging (IM conversation), or both (conversation). The concept of conversations is key to understanding and using the multimedia capabilities of the Multimedia PC Client.

Service package

Your service provider or system administrator assigns a service package with pre-defined features and options for you. Some features will only be available to you if they are listed in your service package. For example, your company may not support PC video cameras and therefore these settings would not be available for you to change. In addition to video, your service package defines how many Friends you can have, how many callers you can join in an audio conference, and whether you have voice mail enabled.

If you have access to the Personal Agent, you can view the features and options available in your service package by logging on to the Personal Agent Quick Start page and clicking on:
Your service package features will not be available on your Multimedia PC Client until you sign in. For more information about the Personal Agent refer to the *Personal Agent User Guide* (NN10039-113).

**STEP 1** - From the Quick Start page click one of the two *Preferences* links.
STEP 2 - From the Preferences page click Services.
STEP 3 - The Service Package details page appears.

Friends

Within your personal address book, you can designate entries as Friends. People that you contact frequently are good candidates as Friends. To access the personal address book click on the Directory button.

If you have marked an address book entry as a Friend, then you can see the online presence status for that entry. Just click the Friends Online button to see your Friends and their online presence status.
**Personal address book**

Your personal address book is accessed from the Directory icon and is a key tool for managing addresses. You can save your addresses for quick call access as well as organize address book entries into groups.

Your personal address book is synchronized across all your network access devices. If you make a change in your personal address book on the Multimedia PC Client, the change automatically appears on your other network access devices (for example, your Multimedia Web Client, and/or your i2002 or i2004 Internet Telephone).

**Global address book**

The global address book is accessed from the Directory icon and is a list of all existing users in the domain. (This list is maintained by your service provider or system administrator.) Using the MCS Client, you can search on a user’s Username/UserID, Name, First name, Last name, or Phone number. You can initiate a call by double clicking or selecting an entry and clicking the Make Call button in the global address book.

**Attention:** The ability to see another user’s presence information is dependent upon your service package. If your service package does not support presence, then you cannot mark any address book entries as Friends. Consequently, you will not see any presence information when using the Friends Online button.

**Attention:** In some markets, the ability to search for another’s information violates privacy regulations; in addition, some users may not want their phone numbers published. Check with your administrator if you want to disable the global address book functionality.
Presence is how you let others users know your status in the network. The Presence of a Converged desktop user is visible to other users only if the user’s MCS Client with Converged desktop service is logged in and running. Use Login > Change My Status or click on the dropdown arrow located beside your current presence status to change your presence state. This lets other users know whether you are online or unavailable.

Auto-Presence is available to Converged desktop users. This allows you to set the system to automatically alert others whether you are away from your PC or on the telephone. This is done by selecting User Preferences > Presence and then selecting the desired checkbox.
With this capability, the off-hook and on-hook status of your Converged Phone determines your Presence state that appears on the desktops of others who have subscribed to you. A login into a MCS Client with the Converged desktop service and manual change of your Presence state can override the Auto-presence service.

**Attention:** The ability to configure automatic presence notifications on the Multimedia PC Client is dependent upon your service package. If your service package does not support automatic presence, then you will not be able to use the automatic presence feature.

**Tip:** Presence status is updated based on the use of the Preferred Audio Device (PAD). For example, the “On the Phone” status can be presented when the PAD is in use.

**Proxy server**

A proxy server is an application that relays data between your Multimedia PC Client and the network. It is responsible for making sure your calls get to your registered access clients, like the Multimedia PC Client. When you connect to the proxy server you need to provide a valid username and password.

The IP address of the proxy server may already be defined in your Multimedia PC Client. If it is not, contact your administrator to obtain the proxy server configuration information.

**Call logs**

The MCS Client keeps a record of all incoming and outgoing calls. It stores these call log entries into an inbox (for incoming calls) and an outbox (for outgoing calls). Your system administrator determines the maximum number of incoming and outgoing call logs that can be stored on the MCS Client.
Routes

A route allows a user to perform different actions on your incoming calls based on a set of conditions or exceptions selected by the user. **Example:** Users can create a route named “lunch” which may be set up to specify that calls received between 12:00PM and 1:00PM Monday through Friday are to be routed to the users mobile phone first and if no answer sent to voice mail.

Routes are defined by the end user through the Personal Agent. Please refer to Personal Agent User Guide (NN10039-113) for details on defining Routes.

Preferred Audio Device (PAD)

Users are able to select the device type that they would like to use for their audio calls. This is done through the MCS Client Converged Desktop Mode by selecting Preferences and then selecting the checkbox for Converged Desktop Mode.
Users can choose between the following settings.

- **Converged Desktop Mode:** In this mode calls to the Converged Desktop user will ring the user’s Converged Phone.

  **Attention:** The user is not able to change which phone is converged. This is set by your system administrator.

The user will receive a popup non-answerable PC Client conversation window on the user’s PC. If both the originating and terminating callers are Converged Desktop users then both parties will receive a pop-up conversation window similar to the one shown below. The call window will stay available until the call is terminated.

- **PC Mode:** When this is selected the Converged Desktop is deactivated and the MCS Client works in the normal manner. Calls to the user ring the MCS Client (if registered) instead of the Converged Phone. A call window appears at the MCS Client (if registered) which behaves like a normal nonconverged MCS Client. When the call is answered voice is routed to the client and not the Converged Phone.

  When your preferred audio device (PAD) is set to “PC” (non-Converged desktop mode), the MCS Client with the Converged desktop service behaves like a regular MCS Client; Presence states are updated in the same manner.
Chapter 2
Getting started

Topics in this section:

• What is the Multimedia PC Client?
• Configurations
• Converged Desktop Mode on the MCS Client
• Features available to Converged Desktop users
• What you need to begin using the MCS Client
• Automatically starting the Multimedia PC Client
• Signing in to the Multimedia PC Client
• Understanding the Multimedia PC Client interface
• Verifying Converged desktop service
• Advanced set-up
• Routing
• Presence
• Managing Contacts
• Using online help

What is the Multimedia PC Client?

The Multimedia PC Client is an application that provides advanced IP telephony features, many of which are not available on a traditional telephone:

• Internet Protocol (IP) calls
• advanced call logging - keep track of incoming, outgoing, and missed calls
• personal address book - stored on the network and synchronized across clients
• global address book - stored on the network
• presence - see who is online and let others know that you are online
• control of Nortel IP Phones 2002 and 2004
• call hold/retrieve
• call park/retrieve
• call transfer (blind or consult)
• file transfer - send and receive files
• sharing tools - web push, shared whiteboard, shared clipboard
• do not disturb (DND)
• IM chat - creating a chat room or joining a private, public, or public with password chat room
• call handling - decline, redirect, or ignore incoming calls
• instant messaging - send and receive text messages
• video calls (on demand, one-way, and two-way video)
• conference calls (requires network conference server)
• COM AddIn support for Microsoft Outlook that allows you to make calls from and import contacts from Microsoft Outlook 2000 and Microsoft Outlook 2002.

The COM AddIn support for Microsoft Outlook that allows you to call from and import contacts from Microsoft Outlook 2000 and Microsoft Outlook 2002 is only supported on the MCS Client.

Configurations

The Multimedia PC Client is available in three configurations:

• “Multimedia PC Client” on page 21
• “MCS Client Set” on page 21
• “Converged Desktop Mode on the MCS Client” on page 21
Multimedia PC Client

The Multimedia PC Client is a software application that transforms your PC into a powerful telephony and multimedia communications tool. The MCS Client in Non-Converged Desktop Mode allows both voice and multimedia to reside on the data network and is Internet Protocol based. This software application runs on your PC and provides access to SIP features and multimedia services.

Most users will choose to use a headset to speak and hear during calls. Optionally, you can use a separate microphone and your computer’s speakers for the voice part of the call (not recommended in open office environments).

Tip: Keep the Multimedia PC Client running in the background whenever you are using your computer so you can easily accept incoming calls.

MCS Client Set

When the Multimedia PC Client controls a Nortel i2002 or i2004 Internet Telephone, the configuration is called a MCS Client Set. The i2002 or i2004 Internet Telephone provides premium-quality voice, while your computer is dedicated to the data and video components of the multimedia conversation.

The MCS Client Set is ideal when your conversations include processing-intensive tasks such as real-time video, which would otherwise consume the bandwidth (CPU and network) required for voice processing.

For more information and details on configuring the MCS Client to control your Nortel IP Phone 2002 or 2004, refer to Nortel Multimedia Client User Guide (NN10041-113).

Converged Desktop Mode on the MCS Client

The Converged Desktop feature allows end users to use their PCs for the multimedia portion of their communication, while using their existing telephone system for voice. The Converged Desktop Mode has several main benefits.
End users can keep using their existing telephone.
Eliminates the fear of lost telephone services.
Less stringent enterprise data network requirements.
Enhanced communication experience to the user without interrupting their traditional telephone service or features in any way.

Features available to Converged Desktop users

Converged Desktop service is designed to enhance the end user’s communication experience. Converged Desktop users will have a variety of new capabilities not previously available to them.

- Redirection of the call based on MCP Personal Agent screening and routing rules they establish.
- Call Logs showing originating and terminating calls.
- Picture calling line identification which allows the other MCP user to see a picture of the party involved in the call.
- Conversation window screen pop-up with all calls to or from other MCP users.
- The capability to accept Point to point video from other Converged Desktop users.
- File Transfer between other MCP users.
- White board sharing between other MCP users.
- Clip board transfer between other MCP users.
- Web Co-browsing between other MCP users.
- Instant Messaging between other MCP users.
- Click to Call which will ring the Converged Phone of the called party.
- Converged phone originated call logs.
- Presence indicator status of the Converged Phone while the user is logged in and running the session.

What you need to begin using the MCS Client

You need the following items to start using the Multimedia PC Client:
a PC configured with the required minimum software and hardware, as described in the following section

• network access with a connection that meets the minimum transmission speed requirements, as described in the following section

**Attention:** The Multimedia PC Client can operate with the minimum hardware and software requirements but the recommended requirements will provide enhanced multimedia communications quality.

### Minimum hardware and operating system requirements

- 550 MHz Pentium-class or equivalent processor
- 28.8 Kbps modem
- Microphone and full duplex sound card
- 48 MB free RAM (This requirement is in addition to the memory requirements of the OS and other concurrent applications.)
- 75 MB free hard disk space
- 640x480 @8bpp (256 colors) VGA graphics card
- Mouse

### Recommended hardware and operating system requirements

- 1 GHz (or higher) Pentium-class or equivalent processor
- 56 Kbps modem or faster network connection (Cable modem, DSL, 10base-T Ethernet connection will provide a better user experience.)
- Full duplex sound card with headset (microphone-headphone combination)
- 64 MB free RAM (This requirement is in addition to the memory requirements of the OS and other concurrent applications.)
- 75 MB free hard disk space
- 800x600 @16bpp (65,536 colors) VGA or better video graphics card
- Mouse
Optional hardware and software requirements

- Nortel i2002 or i2004 Internet Telephone
- USB-based video camera (Web Cam). A 16bpp (65,536) VGA or better video graphics mode is required in order to send video. See Compatible video cameras for more information about video camera support.
- Auto Web Push requires a Web browser: Internet Explorer 6.0 and above or Netscape 7.0 and above
- Microsoft Outlook 2000 and Microsoft Outlook 2002 (if you want to use the Microsoft Outlook AddIn or Import Contacts features)

**Attention:** Using a USB headset for voice communication together with a USB video camera for video communication may have a significant effect on voice quality, or produce a blue screen error.

Installing the Multimedia PC Client software

To install the Multimedia PC Client, double-click the Multimedia PC Client install file you downloaded or received on CD.
The installer application will walk you through the installation process, allowing you to select options, including:

- the location of where the Multimedia PC Client should be installed
- whether or not the Multimedia PC Client should install a desktop icon
- whether or not the Multimedia PC Client should install the Microsoft Outlook COM AddIn
- whether or not the Multimedia PC Client starts automatically
- whether or not you would like to view any important release notes

**Launching the Multimedia PC Client**

Double-select the desktop icon (if present) or select the Nortel Networks PC Client from the Windows Start Menu to open the Multimedia PC Client application.

The first time you use the application, you will be presented with a wizard to walk you through the Multimedia PC Client configuration. Follow the prompts that appear on your screen.
In the User Information page, provide your username. This may have been provided to you by your administrator.

![User Information](image1)

In the Network Information page, provide (or verify) the IP address and domain for the default proxy server. This information may be automatically filled in for you, or may have been provided to you by your administrator.

![Network Information](image2)
In the Connection page, verify that your IP address is shown. Also, select the connection speed that best matches your network connection speed.

The Audio Test Call page is where you can test your microphone and speakers to ensure proper audio send and receive levels.

Converged desktop users click **Next** to skip the Audio Test Call step.
Click **Finish** to end the configuration wizard.
Automatically starting the Multimedia PC Client

The Multimedia PC Client installation presents the option to have the client start automatically whenever you login to your computer. If this option is not chosen and you would still like to start the client automatically with Windows, perform the following steps (dependant on your Windows configuration):

If you are running Active Desktop (Windows 98SE, Windows Me, Windows 2000, Windows 2002):

1. Drag-and-drop the desktop Nortel Networks PC Client icon onto the task bar Start button.
2. Place the file into the Programs Startup program group.

If you are running Windows 98 First Edition:

1. Right-click on the Start menu and select Explore.
2. Drag-and-drop (or copy and paste) the Nortel Networks MCS Client icon into the Start Menu/ Programs/Startup program group folder.

Signing in to the Multimedia PC Client

You will be prompted to sign in to the Multimedia PC Client when you launch it. At other times (for example, if you disconnect or lose connection with the server) you may need to manually sign in.

Tip: If you chose the option to have the Multimedia PC Client automatically start-up, and you set your Network preferences to automatically connect to your proxy server, be sure to select the Remember my password option so that you won’t have to type your password during sign in.
1. Select **Login** and the button beside your default proxy server IP address. The Sign In window appears with your proxy server’s IP address and your username.

![Sign In Window](image)

Attention: A third checkbox option will appear on the Sign In screen to allow you to select video call forwarding for all calls made to your mobile DN (from that DN to your MCS PC Client). Not selecting the checkbox allows you to use both your mobile phone and your PC client at the same time.

2. Enter your password. Click on the **Remember my password** check box if you do not want to enter your password every time you sign in.

3. Click the **Sign me in automatically** check box if you want the Multimedia PC Client to automatically sign in.

   If you select both these options (**Remember my password** and **Sign me in automatically**), then you will not be prompted with the Sign In window again.
4 Select your Location. The physical location you choose appears on the top right of the main GUI and becomes your default location whenever you log on to the MCS Client until you decide to change it again.

![Select Location](image)

**Caution:** You must provide the correct location information on your MCS Client; otherwise, some services, such as emergency and conferencing services, may not work properly. For example, the location you choose determines where you are during an emergency. If you choose Other as your default location, and you have to make an emergency call, the emergency call may route to the incorrect Public Safety Answering Point (PSAP).

**Tip:** If you are logging in from a different location, ensure that you change your location from the Sign In window or access the Tools > Preferences > Users tab from the main menu. For more information, refer on preferences refer to Advanced set-up.
5 Click OK. If you choose Other as your default location, the following warning box appears.

6 Select the Don’t show me this message again if you do not want this window to appear again when you log in to the MCS Client.
Understanding the Multimedia PC Client interface

The Converged desktop service interface

The following figure shows the main window interface that appears when you have your Multimedia PC Client in Converged Desktop Mode.

Verifying Converged desktop service

To verify that your system is running in Converged Desktop Mode, click Preference. This opens to your user profile page and should appear as the figure
below with the checkbox checked for Converged Desktop Mode.
The following figure shows the main window interface that appears in **Non-Converged Desktop Mode** when you start up the Multimedia PC Client.
Main menu actions

The Multimedia PC Client has a very flexible interface and allows the user to perform commands using the menus, the GUI, or hot keys. The following table lists the actions you can perform from the Multimedia PC Client main menu and their corresponding menu location.

<table>
<thead>
<tr>
<th>Menu name</th>
<th>Menu action</th>
<th>Key command</th>
</tr>
</thead>
<tbody>
<tr>
<td>Login</td>
<td>• Login</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Logout</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Change My Status</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Exit</td>
<td></td>
</tr>
<tr>
<td>View</td>
<td>• Directory</td>
<td>Ctrl+D</td>
</tr>
<tr>
<td></td>
<td>• Call Logs</td>
<td>Ctrl+L</td>
</tr>
<tr>
<td></td>
<td>• Friends</td>
<td>Ctrl+F</td>
</tr>
<tr>
<td></td>
<td>• Quick Start</td>
<td>Ctrl+Q</td>
</tr>
<tr>
<td>Tools</td>
<td>• Make Call...</td>
<td>Ctrl+M</td>
</tr>
<tr>
<td></td>
<td>• Send Instant Message...</td>
<td>Ctrl+N</td>
</tr>
<tr>
<td></td>
<td>• Send File...</td>
<td>Ctrl+S</td>
</tr>
<tr>
<td></td>
<td>• Sharing...</td>
<td>Ctrl+G</td>
</tr>
<tr>
<td></td>
<td>• Start Chat...</td>
<td>Ctrl+H</td>
</tr>
<tr>
<td></td>
<td>• Preferences...</td>
<td>Ctrl+P</td>
</tr>
<tr>
<td></td>
<td>• Show Routes</td>
<td>Ctrl+R</td>
</tr>
<tr>
<td></td>
<td>• Personal Agent</td>
<td>Ctrl+A</td>
</tr>
<tr>
<td>Help</td>
<td>• Contents</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Show Tip of the Day</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Capture Logs for Support</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• About...</td>
<td></td>
</tr>
</tbody>
</table>

Attention: Converged Desktop users may not have all menu options available to them.
Main buttons

The main interface provides the buttons to access the following features of the Multimedia PC Client.

**Attention:** Converged Desktop users may not have all of the main button options, listed here, available to them.

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Green" /></td>
<td>Displays the Quick Start menu in a tear-away <strong>Quick Start</strong> window attached to the main GUI.</td>
</tr>
<tr>
<td><img src="image" alt="Call" /></td>
<td>Displays the <strong>Make A Call</strong> window that allows you to make a call.</td>
</tr>
<tr>
<td><img src="image" alt="Chat" /></td>
<td>Displays the <strong>Instant Message</strong> window that allows you to address, compose, and send an instant message.</td>
</tr>
<tr>
<td><img src="image" alt="Address" /></td>
<td>Displays your address book in a tear-away <strong>Directory</strong> window attached to the main GUI window. Right-clicking on a directory entry displays a shortcut menu with actions that can be performed on the selected entry (for example, call, send file, or send instant message.)</td>
</tr>
<tr>
<td><img src="image" alt="Logs" /></td>
<td>Displays your call logs in a tear-away <strong>Call Logs</strong> window attached to the main GUI window. Right-clicking on a call log entry displays a shortcut menu with actions that can be performed on the selected entry (for example, call, send file, or send instant message.)</td>
</tr>
<tr>
<td><img src="image" alt="Friends" /></td>
<td>Displays your Friends in a tear-away <strong>Friends Online</strong> window attached to the main GUI window. You can see the presence state of all your Friends. Right-clicking on a Friend displays a shortcut menu with actions that can be performed on the selected entry (for example, call, send file, or send instant message.)</td>
</tr>
<tr>
<td><img src="image" alt="Settings" /></td>
<td>Displays the <strong>User Preferences</strong> window that allows you to adjust the Multimedia PC Client settings to suit your needs.</td>
</tr>
<tr>
<td><img src="image" alt="Send" /></td>
<td>Displays the <strong>Send File</strong> window that allows you to send one or more files to another user.</td>
</tr>
</tbody>
</table>
Status buttons

The status buttons display important information and provide quick access to the following features of the Multimedia PC Client.

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Network Proxy" /></td>
<td>Connects or disconnects from the network proxy. \nLights up red when you are not connected to the network proxy. \nLights up green when you are connected to the network proxy.</td>
</tr>
<tr>
<td><img src="image" alt="Calls" /></td>
<td>Displays any parked or held calls. \nFlashes if you have any parked calls or calls on hold.</td>
</tr>
<tr>
<td><img src="image" alt="Call Logs" /></td>
<td>Displays your call logs in a tear-away Call Logs window attached to the main GUI window. \nFlashes when you have new calls.</td>
</tr>
<tr>
<td><img src="image" alt="Do Not Disturb" /></td>
<td>Activates/Deactivates local Do Not Disturb (DND). \nFlashes when DND is active.</td>
</tr>
<tr>
<td><img src="image" alt="Voice Mail" /></td>
<td>Calls the voice mail server defined in preferences. \nFlashes when you have new messages.</td>
</tr>
<tr>
<td>Icon</td>
<td>Description</td>
</tr>
<tr>
<td>------</td>
<td>-------------</td>
</tr>
<tr>
<td><img src="image" alt="Video Preferences" /></td>
<td>Displays your video preferences. Single click to display video preferences. Double click for live video capture window to see the camera and control it. Lights up when video is enabled; dims when video is disabled.</td>
</tr>
<tr>
<td><img src="image" alt="i2002/i2004 Internet Telephone" /></td>
<td>Displays your i2002 or i2004 Internet Telephone preferences. Lights up when an i2002 or i2004 Internet Telephone is actively being controlled by the Multimedia PC Client.</td>
</tr>
<tr>
<td><img src="image" alt="Automatic Software Updates" /></td>
<td>Displays your automatic software updates status. The status button turns:  - grey when software updates are current  - yellow while downloading the automatic software updates  - green when automatic software updates are downloaded  - red when automatic software updates fail to download</td>
</tr>
</tbody>
</table>
System tray icon

When started, the Multimedia PC Client places the following icon in the system tray.

![system tray icon](image)

**Tip:** When you are not using the Multimedia PC Client you can click the X in the upper right hand corner to minimize the window. It will continue to run in the system tray and prompt you when you receive a call or instant message.

Double-click on the system tray icon to restore the Multimedia PC Client and bring it to the front of your desktop.

Right-click on the **system tray** icon to access Multimedia PC Client functionality (for example, Make a Call, Send Instant Message, and Start Collaboration).
When the Multimedia PC Client is offline, the icon in the system tray changes to red.
Advanced set-up

For more information on advanced set-up including configuring your preferences refer to *Nortel Multimedia Client User Guide* (NN10041-113).

When on a call with another MCP user either Converged Desktop or Non-Converged, the Converged Desktop user can use the Converged Desktop MCS Client to add video to the call or start collaboration sessions or IM sessions with the party on the other end.

Converged Desktop users can also add a great deal of mobility to their service by using a Nortel IP Phone 2002, 2004 or the Web Client to receive calls (with audio) at locations away from their desk or by setting their Preferred Audio Device to “PC” to use their MCS Client away from their desk. For example, if working from home.

For more information on using these services, refer to *Nortel Multimedia Client User Guide* (NN10041-113).

Routing

A Converged Desktop user has the option to add entries into the Personal Agent route wizard to create custom call routing. For more information and details on setting up routes refer to *Nortel Personal Agent User Guide* (NN10039-113).

**Attention:** Converged Desktop users PAD (Preferred Audio Device) will always ring when the default route is left unmodified in the Personal Agent route wizard. Refer to the section on selecting your Preferred Audio Device (PAD) for more details.

For example: if a Converged Desktop user would like to create a rule to ring their mobile phone follow these steps:

1. Set the Preferred Audio Device (PAD) to “Converged Phone”
2. Access the Personal Agent route wizard by clicking on **Routes**
3 Click the **New** button.

**List of routes**

*Apply routes in the following order*

- Default route

**Route details**

- **New**
- **Modify**
- **Copy**
- **Rename**
- **Delete**

**Buttons**

- **Move up**
- **Move down**
- **Save**
- **Reset**
Select the checkbox for “When a call is received” and click Next.
5 Select the desired checkbox or click Next to apply the rule “When a call is received from anyone.”

**Route Wizard**

Step 2. Conditions
Select how you would like to filter calls received.

- [ ] From **THESE PEOPLE** in my Personal Address Book
- [ ] From **THESE PEOPLE** in my Global Address List
- [ ] From **THESE GROUPS** in my Directory
- [ ] From **THESE TELEPHONE NUMBER(S)**
- [ ] From anonymous

Route details (click on a link to edit)
When a call is received from anyone

[Cancel]  [< Back]  [Next >]  [Finish]
6 Select the checkbox for “Ring my devices in the following ordered lists”, then under this topic select the checkbox for “Ring THESE NUMBERS first in my list”

**Route Wizard**

**Step 3. Actions**

Select what actions you would like to perform.

- Ring my devices in the following ordered lists
  - Ring THESE NUMBERS first in my list
  - Ring THESE NUMBERS second in my list
  - If no answer then send to voicemail
- Send straight to voicemail

**Route details (click on a link to edit)**

When a call is received from anyone
7 Click on **THESE NUMBERS** link in the line you have checked to input your mobile number and click **OK**.

![Personal agent - ...](image)

8 Repeat steps 6 and 7 for the checkbox “**Ring THESE NUMBERS second in my list**” and input your Converged Desktop user’s SIP ID address, for example: john@any-company.com, then click **OK** to close this window.

**Attention:** When a user creates a new route other than default, the user must add “ring my client” in their ring list, if the PAD is to be rung. If this is not done, then the PAD will not be rung.

9 Click **Finish** and select to make the new route active.
Presence

For more information on understanding and managing your Presence, refer to Nortel Multimedia Client User Guide (NN10041-113).

**Attention:** As a Converged Desktop user, presence information is provided only when you are registered as a Converged Desktop MCS Client user and your session is active. This is known as “auto presence” and allows the converged phone to update the presence status as the Converged Desktop user originates and/or terminates calls within your designated circle of “Friends” that subscribe to you in your Friends Online list.

Also: Manually changing your user’s presence state can override the “auto presence” state detection.

Managing Contacts

For detailed information on managing contacts, refer to Nortel Multimedia Client User Guide (NN10041-113).

Using online help

There are several ways that you can access Multimedia PC Client help:

- tool tip help - a small help description that is available when you roll your mouse over a button on the Multimedia PC Client main interface
- tool tip help from the system tray icon - roll your mouse over the icon to see the tool tip help. The Multimedia PC Client displays the most relevant information in the tip, for example:
  - your presence status
  - whether or not there are new calls
  - whether or not there are new voice mail messages
- online help - from the Multimedia PC Client main menu, select Help > Contents to view a task-based help system. The online help provides
— help pages containing forward and backward navigation icons
— procedures that help you use the Multimedia PC Client
— links to all topics
— a table of contents with hypertext links
— an index
Chapter 3
Multimedia communication

Topics in this section:

- “Making a call with Converged desktop service” on page 52
- “Receiving a call” on page 58
- “Sending and receiving video” on page 59
- “Answering a video call” on page 60
- “Ending a voice or video call” on page 60
- “Starting a sharing conversation” on page 63
- “Starting a whiteboard, clipboard, and web page sharing operation without a call” on page 64
- “Ending a sharing conversation” on page 69
- “Sending web pages” on page 69
- “Transferring files (Sending files)” on page 74
- “Receiving files” on page 77
- “Accessing received files” on page 79
- “Sharing a whiteboard” on page 79
- “Using the whiteboard” on page 84
- “Making an E911 call” on page 92
- “Parking a call” on page 94
- “Conference calling” on page 95
- “Sending instant messages” on page 96
- “Using voice mail” on page 97
- “Setting up SimRing for your desktop phone” on page 99
Making a call with Converged desktop service

There are multiple ways to initiate a call (voice conversation) using the Multimedia PC Client with Converged desktop service.

The most common ways to make a phone call are to:

- select an entry from within Microsoft Outlook and click on the optional Multimedia PC Client COM AddIn Call button. Refer to “Making a call within Microsoft Outlook” for steps to use this procedure.
- double-click on any Directory, Call Logs, or Friends Online entry. You can double-click on any of the MCP directories.
- right-click on any Directory, Call Logs, or Friends Online entry, and then select Call from the shortcut menu that appears. Right-clicking is a quick way to access extended actions that you can perform on a selected entry. See the following figure.
- use the Make A Call button and manually enter a SIP User ID address or a phone number. Refer to “Manually making a voice or video call with Converged desktop service” for steps to use this procedure. There is additional information about steps of a video call in the section “Sending and receiving video”.

![Image of Converged Multimedia PC Client]

![Image of Call Logs]

NN10426-112
You can double or right-click on any of the Multimedia Communication Platform (MCP) directories such as your Global Address book or your Personal Address Book.

You can also dial the number of the called party from your Converged Phone.

Making a call within Microsoft Outlook

You can make a call from within Microsoft Outlook 2000 and Microsoft Outlook 2002 if you have installed the optional Outlook COM AddIn.

Attention: The COM AddIn that allows you to call from and import contacts from Microsoft Outlook 2000 and Microsoft Outlook 2002 is only supported on the MCS Client.

To make a call (the COM AddIn must be installed and the Multimedia PC Client must be running) from within Outlook 2000

1 Select an email, contact list entry, or meeting request in an Outlook 2000 folder.

2 Click the Call button on the main Outlook 2000 tool bar. Click on the optional MCS Client COM AddIN Call button. If multiple telephone numbers are found for the selected entry, the COM AddIn will prompt you to select which number to dial.

The Multimedia PC Client calls the number provided by the COM AddIn.
3 Answer the Converged Phone when it rings. If the Converged Phone fails to ring, a message appears on the originator’s call window and the Click to Call attempt ends.

**Tip:** If you are a Converged desktop user on the MCS 5100 system, you can add or remove video only after the call is answered. Once the call is answered, click the **Start Camera** icon to add video to your call. If you are on the MCS 5200 system, you can add or remove video before or without answering the call. To use the video capability, one of the users must have a video camera, and both users must have a MCS Client or Multimedia PC Client with Converged Desktop service.

The **Conversation** window contains the following buttons and status information in the call control panel:

**Manually making a voice or video call with Converged desktop service**

To make a call from your MCS Client with Converged desktop service

1 Select **Tools > Make Call...** or click the **Make A Call** button on the main GUI of your Multimedia PC Client with Converged desktop service. The **Make A Call** address window appears.
Enter an address (username, SIP address, or public telephone number) in the Make Call to... field. When dialing a public telephone number, do not add punctuation to the number. For example, 9725556245 is a valid public telephone number while 972-555-6245 is not.

From the Make A Call, you can access your personal address book as well as a redial list of the last five incoming and outgoing calls. See the following figure.

Click the Recent and/or Directory buttons to access these extra address resources.
Enter or select an optional call subject in the Subject... drop-down menu.

Click either the Make Phone Call or Make Video Call button to make a call to the address you have entered.

Tip: To make video call successfully, ensure that you enable the video option from Tools > Preferences > Video tab, which you access from the main menu.

If you are a Converged desktop user on the MCS 5100 system, you cannot start video until the call is answered. Once the call is answered, you can click the Start Camera icon for a video call in the Conversation window. However, if you are a Converged desktop user on the MCS 5200 system, you can start video before or without answering the call.
To use the video capability, one of the users must have a video camera, and both users must have a MCS Client or Multimedia PC Client with Converged Desktop service.

**Attention:** The ability to make video calls is dependent on your service package. If you do not have video support you will not be able to make video calls.

Answer your Converged Phone. The system attempts to contact the person you called. Once the called party answers, the **Conversation** window appears.

If the Converged Phone fails to ring the called party, a message appears on the originator's call window and the Click to Call attempt ends.

**Attention:** When you make a call to a party who is outside of the MCS 5100 or MCS 5200 system, a conversation window (screen pop-up) does not appear. When you call a non-MCS party, you will be unable to exchange video or instant messaging or perform other multimedia tasks with that party.
Receiving a call

When the MCS Client with Converged desktop service receives an incoming call, a receiving call Conversation window displaying **Receiving Call...** appears on your desktop.

Because the MCS Client with Converged desktop service does not provide voice, the call control panel of the **Conversation** window does not display.

The incoming **Conversation** window contains the following buttons and status information:

- The **name** of the calling party appears in the title bar.

  The name displayed in the window is selected using the following order of precedence:
  
  - If the calling party is defined in your personal address book, then the user’s **nickname** is displayed.
  
  - If the user has provided a **display name** and the user is not in your personal address book, then their **display name** is displayed.
  
  - If the calling party is not in your personal address book, and no **display name** is provided, then the user’s **username** is displayed.

- If the caller provides a network calling picture ID, a photo of the caller appears. The user’s **name** also appears at the bottom of the user’s photo.

- If the calling party provides a subject for the call, the **call subject** displays in the **Subject** area.

- **Stop** - Closes the **Conversation** window.

- **Instant Message** - The **Conversation** window expands to show the instant messaging control panel where you can enter a message to send to the caller.
• **Send File** - The *Conversation* window expands to show the share control panel. A file chooser dialog window also opens to allow you to select a file to send to the caller.

• **Share** - The *Conversation* window expands to show the share control panel. From there you can access the Multimedia PC Client sharing tools:
  — **Send File** - Send files to the other user.
  — **Share Whiteboard** - Shares a common whiteboard with the other user.
  — **Transfer Clipboard** - Sends the contents of your system clipboard to the other user.
  — **Send Web Page** - Sends web pages for viewing on the other user’s system. As a Converged desktop user, you can only push Web pages to other Converged desktop users.

• **Call Duration** - Shows the length of your conversation with the other user.

• **Start camera** - Adds video to the call.

• **End Video** - Stops video. However, the voice call can still remain active.

### Sending and receiving video

Your MCS Client with Converged desktop service enables you to make both voice and video calls. For video calls you must have a web camera for your PC so you can transmit video to the other party. A high-bandwidth network connection and fast PC processor are recommended for optimal video performance. If the other party has a camera and subscribes to video service, then you can receive the party’s video transmission as well.

**Tip:** For more information about how to make or receive video calls, see “Answering a video call” and “Ending a voice or video call”.
There are pre-defined video configurations for:

- Very low bandwidth (Dialup modem)
- Low bandwidth (ISDN, Cable modem, DSL)
- Medium bandwidth (High speed LAN)
- High bandwidth (High speed LAN)
- Receive-only video
- No receipt or sending of video on calls

In addition, the Multimedia PC Client with Converged desktop allows you to specify a custom video configuration.

The default setting for video is receive-only video. Before you can send video you must configure the video settings. Refer to the Nortel Multimedia Client User Guide (NN10041-113) for more information on video configuration procedures.

**Answering a video call**

To answer an incoming call, click **Start Video** in the **Conversation** window that appears. The call control panel for the **Conversation** window changes to include active call controls.

**Ending a voice or video call**

To end a call, click the **Stop** button in the top right-hand area of the **Voice Conversation** window.

Ending a voice conversation does not necessarily close the Conversation window. If there are other active conversations with the user, the window stays open (for example, if the instant messaging control panel is open, the Conversation window remains open, even after the voice conversation has ended).
If you try to close the **Conversation** window during an active call the following window appears.

- Select **Yes** if you wish to end the call.
- Select **No** if you do not wish to end the call.
Chapter 3  Multimedia communication

Sharing

Understanding sharing

The MCS Client with Converged desktop service allows a Converged desktop user to team with another Multimedia Communication Server (MCS) user in multimedia communication (for example, exchange of files or web pages).

The MCS Client with Converged desktop service offers the following sharing tools:

- **Send File** -- enables you to send files to another MCS user
- **Share Whiteboard** -- enables you to collaborate with another MCS user by entering text and graphic objects in a shared work space. Both you and other user can make changes in the shared whiteboard and view it equally.
- **Transfer Clipboard** -- enables you to send the contents of your Windows system clipboard.
- **Send Web Push** -- enables you to send web pages to another MCS user. A Converged desktop user can receive a web push on the MCS Client with Converged desktop service.

**Tip:** With the exception of the **Send Web Push** command, the Sharing action function only when the sending and receiving parties are both using a MCS Client.
Starting a sharing conversation

1. Make or answer a call.
2. Press the Share button on the active Conversation window (screen pop-up). The Conversation window expands to show the sharing control panel. See the sharing control panel in the highlighted area in the following figure.

3. Select the sharing tool you wish to use by clicking on one of the button in the sharing control panel: **Send File**, **Share Whiteboard**, **Transfer Clipboard**, or **Send Web Page**.
Attention: With the exception of the Send Web Push command, the Sharing actions are only available when the other user is also using the MCS Client.

Starting a whiteboard, clipboard, and web page sharing operation without a call

To start a sharing operation to access the Share Whiteboard, Transfer Clipboard, or Send Web Page sharing tools

1. Select Tools > Sharing or the Sharing button on the main GUI. The Sharing address window appears. See the following figure.
2 Enter an address (username or SIP address) in the **Share with...** field. The Sharing address window also includes access to your personal address, names in your Friends Online list, and a list of SIP addresses that you have most recently contacted. Click the **Friends, Recent** and or **Directory** button to access these extra address resources. The highlighted area in the following graphic appears after you click the **Directory** button.
Tip: When starting a sharing operation from a Directory entry, Friends entry, Call logs entry, or a Conversation window (screen pop-up) for an active or incoming call, you are presented with the sharing control panel directly (either as part of an existing Conversation window or for a new Sharing Conversation window). You do not have to enter the Share with...recipient address using the Sharing address window.

3 Click the sharing tool (Share Whiteboard, Send Web Page, or Transfer Clipboard) you want to use. A Sharing Conversation window appears, automatically starting the sharing tool you have selected.

**Starting a Send File sharing conversation without a call**

To start a Send File sharing conversation

1 Select Tools > Send File... or the Send File button on the main GUI. The Send File address window appears.

2 Enter an address (username or SIP address) in the Send File to... field. The Send File window also includes access your personal address book, people in your Friends Online list, and a list of SIP addresses that you have most recently contacted. Click the Friends, Recent and/or Directory buttons to access these extra address resources. See the following figure to see the window that appears after you click the Directory button.
3 Click **Select File...**, and the **Sharing Conversation** window and file Open dialog window appear, as follows.

**Tip:** When starting a Send File sharing conversation from a Directory entry, Friends entry, Call Logs entry, or a Conversation window for an active incoming call, you are presented with the sharing control panel directly (either as a part of the existing Conversation or for a new Sharing Conversation window). It is not necessary to enter the Send...recipient address using the Sharing address window.
See the following figure to see how the window looks during an attempt to send a file.
Ending a sharing conversation

To end a sharing conversation, Click **Stop** in the Conversation window you want to end. The MCS Client with Converged desktop service ends all conversations related to the Conversation window, and the window is removed from your desktop.

Sending web pages

The MCS Client with the Converged desktop service lets you push (send) web pages for display on another user’s screen. It also enables you to view web pages pushed from another user.

Pushing a web page to another party on an active call

**Attention:** A Converged desktop user can push web pages to only other Converged desktop users.

To push the active web page on your browser to another party on an active call:

1. Click **Share** in the Conversation window for the call. The Conversation window expands to show the sharing control panel.

2. Click **Send Web Page** from the sharing control panel. The MCS Client with Converged desktop service displays a window to enter or confirm a web page selection to be pushed to another computer.

If the MCS Client with Converged desktop service is able to communicate with a compatible running web browser application, a **Confirm Web Push** window appears with the current web URL already entered for you.

3. Click **Yes** to push the web page to the other computer.
4 If the MCS Client with Converged desktop service is unable to communicate with a compatible running web browser application, an empty Web Push window opens. Enter a URL and select OK to push the web page to the other computer.

**Pushing a web page to another party not on an active call**

**Attention:** A Converged desktop user can push web pages to only other Converged desktop users.

1 Select Tools > Sharing... or the Sharing button on the main GUI. The Sharing address window appears.

![Sharing window](image)

**Tip:** When sending a web page directly from a Directory entry, Friends entry, Call Logs entry, or a Conversation window for an active or incoming call, you are presented directly with a panel (either as a part of an existing Conversation window or for a new Sharing Conversation window). It is not necessary that you enter the party’s SIP address using the Sharing address window.
2 Enter an address (username or SIP address) in the Share with... field. The Sharing address window also includes access to your personal address book, names in your Friends Online list, and a list of the SIP addresses that you have mostly recently contacted. Click the Friends, Recent and/or Directory buttons to access these extra address resources.

3 Click Send Web Page. The Sharing Conversation window appears.

4 If the MCS Client with Converged desktop service is able to communicate with a compatible running web browser application, a confirm Web Push window appears with the current web page URL already entered for you. Click Yes to push the web page to the other computer.

5 If the MCS Client is unable to communicate with a compatible running web browser application, an empty Web Push window opens. Enter a URL, and click OK to push the page to the other computer.
Receiving web pages

When you receive a web page, the Conversation window expands to show the sharing control panel in which you can decide whether to view the page.

To view a received web page

1. Click **Open** in the sharing control panel.

Then the MCS Client with Converged desktop service opens your default web browser application and displays the received page.

2. The MCS Client with Converged desktop service displays a dialog box with which you can choose whether the MCS Client with Converged desktop
service automatically displays future received web pushes. Click OK if you want to automatically display future received Co-browsing web pages.

**Tip:** The recommendation is that you allow the MCS Client with Converged desktop service to automatically view received web pages, especially if the other party is using the MCS Client’s with Converged desktop service. The choice to automatically view received web pages makes it so that it is not necessary to click the Open button for every web page you receive.

During a web push, if the MCS Client with Converged desktop service is able to communicate with a compatible running web browser application, you have the option to set the MCS Client with Converged desktop service to automatically push (send) any subsequent web pages you view to another computer.

**Attention:** Web Co-browsing is not available for SimRing (type 1) users. Co-browsing is not available when using the MCS Client with Converged desktop service to send a web page to a user not on an active call.

**Attention:** To use Co-browsing, you must have a compatible browser application running. Netscape version 7.0 or later or Internet Explorer version 6.0 or later is recommended.

**Attention:** You can perform Co-browsing only in an active call with another party.

To activate Co-browsing when pushing a web page

1. Select the **Enable** auto web push check box from the Confirm Web Push window. Then the MCS Client with Converged desktop service will automatically send all subsequent pages you view to the other computer.
While the Co-browsing function (auto web push) is active, the \textbf{Send Web Page} button flashes in the Sharing Control panel for the Conversation window.

\textbf{Attention:} If the MCS Client with Converged desktop service receives a web page while auto web push is active, it deactivates auto web pushing. This behavior prevents two MCP systems from getting into a web pushing loop with each other.

## Transferring files (Sending files)

The MCS Client with Converged desktop service lets you send (and receive) files to (and from) another user of the regular MCS Client (without Converged desktop service) and MCS Client with Converged desktop service.

### Sending files

To send a file

1. Click \textit{Share} in the Conversation window for the call. The Conversation window expands to show the sharing control panel.
2 Click Send File from the sharing control panel.

3 The MCS Client with Converged desktop service displays a file section dialog window where you can select a file to send to other MCP party on the call. See the following figure. Using the file dialog, select a file and click Open to initiate the file transfer.
The MCS Client with Converged desktop service contacts the other party in the call and waits for the file send request to be accepted or rejected. While waiting for other party’s acceptance, the file transfer appears in the pending state in the sharing control panel.

**Tip:** Before the receiving party has accepted or rejected your file send request, you have the option to cancel the file send action. Click on the **Stop** button to cancel the file send action.
If the receiving party accepts the file transfer, the file is sent, and the sharing control panel indicates that the file has been sent successfully.

**Receiving files**

When another MCP party sends a file to you, your Conversation window expands to show the sharing control panel, and the MCS Client with Converged desktop service displays the file transfer request in the pending state.
In order to accept the file, click the **Accept** button in the sharing control panel. The file transfer to your computer. The sharing control panel display indicates when the file transfer is complete.

In order to reject the file, click the **Reject** button in the sharing control panel.
**Accessing received files**

After you accept a file, you can open an Explorer window to access the sent file. The MCS Client with Converged desktop service provides quick access to the received file. In order to locate the file, click the **Open** button for the file in the sharing control panel.

The MCS Client with Converged desktop opens a Window Explorer directory to its incoming file directory.

**Sharing a whiteboard**

The MCS Client with Converged desktop service lets you and another MCP user share a common drawing window. The Share Whiteboard tool lets both users draw to the window and see the results of the shared whiteboard.
Sending a whiteboard request

To start a sharing whiteboard

1. Click Share in the Conversation window for the call. The Conversation window expands to show the sharing control panel.

2. Click Share Whiteboard from the sharing control panel. The MCS Client with Converged desktop service attempts to reach the other party and waits for the party to accept or reject the share whiteboard request. During this period of waiting for acceptance, the share whiteboard request is in the pending state. See the following tip.
Tip: Before the other party accepts or rejects your share whiteboard request, you have the ability to cancel the share whiteboard request. Click Stop to cancel the share whiteboard request.

If the other party accepts the share whiteboard request, the whiteboard application starts, and the sharing control panel indicates that the whiteboard is open.

If the other party has rejected the share whiteboard request, the whiteboard application does not start, and the sharing control panel indicates that the file transfer has failed.
Receiving a share whiteboard request

If the other party in a call initiates a Share Whiteboard command from the sharing control panel of a Conversation window, then your Conversation window expands to show the sharing control panel. The MCS Client with Converged desktop service displays the share whiteboard request in a pending state.

In order to accept the share whiteboard request, click Accept in the sharing control panel. The share whiteboard application starts. The sharing control panel display indicates acceptance of the shared whiteboard request.

![Sharing Conversation Window](image-url)
In order to reject the share whiteboard request, click **Reject** in the sharing control panel. Your sharing control panel will indicate rejection of the request.
Using the whiteboard

After the acceptance of the share whiteboard request, the MCS Client with Converged desktop service displays the Whiteboard window.

Keep the following guidelines in mind when using the whiteboard work space:

- Use the object drawing tools (circle, square, polygon) to create shapes and lines.
- The drawings are vector drawing, not bitmaps. The fact that they are vector drawings means you can move, edit, or delete the objects that you create with these tools, rather than manipulate them pixel by pixel (as you can with paint type programs).
- Use the color selectors to choose colors for drawing objects and text.
- Use the line weight selectors to choose the thickness of drawing lines.
- Both you and the other user can edit the whiteboard drawing space. Both of you can view the results immediately.
Saving whiteboard drawings

To save whiteboard drawings

1. Select **File > Save** from the menu on the **Whiteboard** window. A **Save Whiteboard** window appears.
2. Select a location, and enter a filename in the window.
3. Click **Save**. The MCS Client saves the files to the location and filename that you specified.

Restoring whiteboard drawings

To restore whiteboard drawings

1. Select **File > Restore** from the menu on the **Whiteboard** window. An open dialog window appears.
2. Browse to select the previously saved whiteboard drawing.
3. Click **Open**. The Whiteboard window updates to display the saved whiteboard drawing.

Transferring the clipboard

The MCS Client with Converged desktop service lets you send and receive Windows clipboard data to and from another user’s MCS Client with Converged desktop and regular MCS Client (without Converged desktop service). You can share clips of text, photos, drawing, Web bookmarks, email address books, and other clipboard contents. When a conversation successfully starts, two users can send Window clipboard data using the **Transfer Clipboard** tool.

**Attention:** Certain items copied to your clipboard file such as file icons, cannot be copied and sent using the **Transfer Clipboard** sharing tool. Use the **Send File** sharing tool to send these items.
Placing content in the Windows clipboard

Before you are able to transfer clipboard data to another MCP user, you must place some data into the system clipboard.

To put content in the clipboard

1. Open the application and file containing the desired content you want to transfer.
2. Select and highlight the portion of the file you wish to exchange through the clipboard.
3. Use that application’s **Copy** function to copy the content to the system clipboard.

**Tip:** For most applications, the keyboard shortcut command is `<CTRL-C>`, and the menu command is **Edit > Copy**. The selected contents are automatically placed in your Windows system clipboard.

Sending clipboard data

Once the system clipboard contains data, you can transfer it to the remote user.

To send the clipboard data

1. Click Share in the Conversation window for the call. The **Conversation** window expands to show the sharing control panel.
2. Click Transfer Clipboard from the sharing control panel. The MCS Client with Converged desktop service contacts the other party and waits for the transfer clipboard request to be accepted or rejected. While waiting for the other party’s acceptance, the transfer clipboard request is in the pending state. See the following figure.
If the other party accepts the transfer clipboard request, the clipboard data is sent, and the sharing control panel indicates that the data transfer has been completed successfully. See the following figure.
If the other party rejects the transfer clipboard request, the clipboard data is not sent, and the sharing control panel indicates that the data transfer request was rejected.

**Receiving a transfer clipboard request**

If the other party in a call initiates a Transfer Clipboard command from the sharing control panel of a Conversation window, your Conversation window expands to show the sharing control panel and displays the clipboard transfer request in a pending a state, as follows.
In order to accept clipboard data, click Accept in the sharing control panel. The data is transferred into a system clipboard. The sharing control panel display indicates when the data transfer finishes. It also indicates what type of data was transferred, as follows.
In order to reject the clipboard data, click the **Reject** button in the sharing control panel. The sharing control panel display indicates that the data transfer has not been transferred to your system clipboard.

**Using or saving the received clipboard data**

To use or save the transferred clipboard data

1. Open the Window application(s) in which you want to use the clipboard data.
2. Use the **Paste** function of that application to paste data from the system clipboard into the application.

   **Tip:** For most applications, the keyboard shortcut command for pasting clipboard data is `<CTRL-P>`, and the menu command is **Edit > Paste**.

3. Edit and save your data in the Windows application. See the following tip.
Making an E911 call

While in the Converged desktop mode, you cannot originate an E911 call from the MCS Client with Converged desktop service because it does have audio capabilities. However, if you deactivate the Converged desktop service (uncheck the Converged desktop mode), then you can make a call from the MCS Client. See the highlighted box that you can uncheck in the following figure.

Attention: When you use this feature, you will not be able to disconnect the call (the only party to disconnect the E911 call is the PSAP), nor will you be able to use other mid-call features (e.g., Hold, Transfer, Call Park) until the call is disconnected.

You can also make an E911 call from the preferred audio device (Converged Phone).
Disabling call waiting

If you do not wish to receive any incoming calls while you are on an active call, you can have your system administrator activate the call waiting disable feature. When this feature is enabled you do not receive any incoming call pop-up windows, allowing you to focus on your current call. The rejected incoming calls are logged into your incoming call logs as missed calls.

**Attention:** Activating the call waiting disable feature does not affect instant messaging, collaboration capabilities, or making outgoing calls.

When the system administrator activates the call waiting disable feature, the caller receives one of the following:

- a busy tone
Parking a call

As a Converged desktop user, you cannot use the Call park function. (The Converged desktop service cannot be enabled for a user with the Call park service.) However, a non-Converged desktop with the Call park functionality can park a Converged desktop user.

The Call park service allows a user to place a call on hold so that someone else can retrieve it. The call can be returned to the user if it is not picked up after a specified amount of time.

Other services unavailable in the Converged desktop mode

As a Converged desktop user, you cannot use the following services while in the Converged desktop mode:

- Assistant console and Assistant support services. These services cannot be assigned to a Converged desktop user.
- Ad-hoc Conference. The MCS Client with Converged desktop service does not support conference call initiations. However, individual using other MCS access clients can include a Converged desktop user in a Conference call. (The term ad-hoc refers to spontaneous or on-the-spot conferences.)
- Message waiting indicator (MWI). Refer to the “Using voice mail” on page 97 for additional information about the MWI.
- Redirect. Even though you cannot use this service, another access client can redirect your MCS Client with Converged desktop service and Converged Phone before a call is answered.
• Transfer. Even though you cannot use the MCS Client for this service, you can use a Converged Phone to transfer a call terminating to it or originating from it. A user of another MCS access client can transfer your call.

If you are a Converged desktop user, you cannot use the consult transfer function before answering a call. However, a MCS Client user can redirect a Converged desktop user before answering a call.

When you are transferred out of a call, your presence will continue to appear as active and your MCS Client with Converged desktop screen pop-up (conversation window) will continue to appear. In this case, the Presence state appears as “Active Available.” The client session with the Converged desktop service will end when your conversation to the party to whom you are transferred ends.

When your call is transferred to another Converged desktop user, you will receive another screen pop-up.

Attention: When you are in the non-Converged Desktop mode, you can generally use all of these services. Refer to Converged Desktop Mode on the MCS Client for deactivation of the Converged mode.

Conference calling 🗣️

You can use the Multimedia PC Client with Converged desktop service to set up network-hosted audio conference calls. The maximum number of parties that can be joined together in a network-hosted audio conference is dependent on your service package.

As a Converged desktop user, you cannot initiate an Ad hoc audio conference call, that is, create a conference at random by joining multiple calls together into one conference call. However, users on other access clients can include a Converged desktop user into such a conference call.

As a Converged desktop user, you can set up a Meet me audio conference call in the language of your choice (if supported). The audio prompts of the conference and the display on the collaboration web pages will also be represented in the selected language.
In addition, the Meet me audio conference service does provide operator control capabilities (such as to launch a chat session, enable/disable entry/exit tones, lock/unlock the conference), and enhanced usability (such as starting the conference before the chairperson arrive, call for operator without transferring out of the conference, and audio recording for the chairperson).

For more information about Meet me audio conference, refer to Nortel MCS 5200 Feature Overview (NN10251-115).

**Sending instant messages**

Instant messaging allows you to send and receive text notes among one or more recipients, even while you are engaged in an active call. You can send instant messages (IMs) only to other users on the Multimedia Communication Server (MCS) system (Converged desktop or non-Converged desktop users).
You can send an instant message in any of the following ways:

- From the main tool bar of the Multimedia PC Client with Converged desktop service, select the **Instant Message** button. This client displays an **Instant Message** address window for you to select recipient(s) and enter the message.
- From the main menu of the Multimedia PC Client with Converged desktop service, select **Tools > Send Instant Message**... This client displays an **Instant Message** address window for you to select recipient(s) and enter the message.

**Tip:** Bring up the **Instant Message** address window by pressing <CTRL-N>.

Refer to *Nortel Multimedia Client User Guide* (NN10041-113) for more ways to send instant messages, to respond to instant messages, and to send IM broadcasts (instant messages to multiple users).

### Using voice mail

The Multimedia PC Client with Converged desktop service gives you point-and-select access to your voice mail service from your organization or network provider. Your service package and system configuration determines whether you can access the integrated voice mail commands that the Multimedia PC Client with Converged desktop service provides. Contact your service provider for details on obtaining network-based voice mail and ensuring that your unanswered calls go to your network voice mailbox.

There are two ways that a system administrator can set up your voice mail:

- to be hosted off of your network. In this scenario, no indication appears in the main Graphical User Interface (GUI) of the MCS Client with Converged desktop service. Call logs from the GUI of your MCS Client with Converged desktop service will indicate that call was answered.
- to be hosted off of your MCS system. In this case, the voice mail icon at the top of main GUI of this access client will flash until you listen to the message.
Contact your system administrator to find out how your voice mail system is set up.

**Tip:** When your Preferred Audio Device (PAD) is set up “PC” and you use TDM-based mail, calls will not roll over to voice mail. Contact your system administrator to find out how your PAD is set up. With this arrangement, the client will ring, but the Converged Phone will not ring. To use TDM-based voice, you must add an entry to your Personal Agent rules that rings the Converged Phone. Refer to Nortel Personal Agent User Guide (NN10039-113) for information about setting up routes.

Refer to the chapter “Setting up network-based voice mail access (optional)” in Nortel Multimedia Client User Guide (NN10041-113) for more information on configuring the Multimedia PC Client with Converged desktop service for use with a voice mail system.

**Tip:** Before accessing your voice mail through the Multimedia PC Client with Converged desktop service for the first time, you must configure the client to contact your voice mail system.

**Attention:** The ability to use Unified Communications services is dependent upon your service package.

### Message Waiting Indicator (MWI)

If your service package enables access to your network-based voice mail server, then when a user leaves you a voice mail message, the Multimedia PC Client with Converged desktop service alerts you by flashing the Voice Mail status button on the main GUI. If you do not subscribe to network-based voice mail service, the Voice Mail status button does not flash.
Accessing your voice mailbox

Before using the Voice Mail button to access your voice mail server, you must configure the Multimedia PC Client with Converged desktop, providing the command digits for the various voice mail commands. See the chapter “Setting up network-based voice mail access (optional)” in Nortel Multimedia Client User Guide (NN10041-113) for information about configuring the Multimedia PC Client voice mail command buttons. To access your voice mailbox, you can either:

- make a call to the voice mail number from the MCS Client with Converged desktop service by using the Click to Call mechanism. This access client makes a call to your voice mail server. A Conversation window and extended call control panel opens that enables you to interact easily with the voice mail system. See the figure above.

  **Attention:** Double-clicking on the voice mail icon does not call the voice mail number.

- directly dial the voice mail number from your Converged Phone.

Setting up SimRing for your desktop phone

The SimRing Converged desktop service functionality allows you to set up your calls to your desktop phone to ring other endpoints (for example, your MCS Client with Converged desktop or cell phone). It is an activity that was released before the Session Initiation Protocol (SIP)-based Converged desktop service. Refer to “Features and services” on page 7 for more information on SimRing.

To set SimRing for your desktop phone
Dial the number provided by your system administrator to access the SimRing service.

Enter your external number (not the phone number used internally in your office) with its area code. After you enter it, the pound sign (#).

Follow the steps provided in the announcement.

Press the 3 on the phone’s dial pad to activate the SimRing service. You also can press 3 to deactivate the SimRing service. (The numbers that you entered to ring when you desktop phone is called will remain in the list after you deactivate the service.)

**Attention:** The service area range of a cell phone can sometimes affect whether SimRing service will function with it.

This service does not function if your Call forwarding remote access is activated.

**Attention:** The SimRing service forwards voicemail to the system that your desktop phone uses.
Appendix A
Button references

This section describes the following buttons on the Multimedia PC Client:

- “Conversation window – Incoming call buttons” on page 101
- “Conversation window – Call control buttons” on page 102
- “Conversation window – Voice mail control buttons” on page 103
- “Conversation window – Sharing buttons” on page 104
- “Conversation window – Instant Message buttons” on page 104

Conversation window – Incoming call buttons

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1.jpg" alt="Answer without video" /></td>
<td>Answers the incoming call without video.</td>
</tr>
<tr>
<td><img src="image2.jpg" alt="Answer with video" /></td>
<td>Answers the incoming call with video.</td>
</tr>
<tr>
<td><img src="image3.jpg" alt="Reject call" /></td>
<td>Rejects the incoming call request. The user can select whether or not to include a reason.</td>
</tr>
<tr>
<td><img src="image4.jpg" alt="Instant Message" /></td>
<td>Displays an integrated Instant Message area inside the <strong>In Session</strong> window that allows you to compose and send an instant message to the other party.</td>
</tr>
<tr>
<td><img src="image5.jpg" alt="Ignore call" /></td>
<td>Ignores the incoming call. The calling party is unaware that the call has been ignored.</td>
</tr>
<tr>
<td><img src="image6.jpg" alt="Redirect call" /></td>
<td>Displays the <strong>Redirect Call</strong> window that allows you to forward an incoming call to another destination.</td>
</tr>
</tbody>
</table>
## Conversation window – Call control buttons

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>🎤</td>
<td>Ends the call.</td>
</tr>
<tr>
<td>🎧</td>
<td>Holds/retrieves an active/held call.</td>
</tr>
<tr>
<td>🎤</td>
<td>Mutes/un-mutes the microphone.</td>
</tr>
<tr>
<td>🎥</td>
<td>Requests activation/de-activation of video for the call.</td>
</tr>
<tr>
<td>🛍️</td>
<td>Parks (holds) a call in a general lot for any user in the domain to retrieve it, or parks (holds) a call for a specific user.</td>
</tr>
<tr>
<td>🔄</td>
<td>Changes the audio codec for the call (downshift/upshift).</td>
</tr>
<tr>
<td>🛋️</td>
<td>Places the call on hold and brings up a new Make A Call window so you can initiate a new call.</td>
</tr>
<tr>
<td>🛋️</td>
<td>Places the call on hold and brings up a new Make A Call window so you can initiate a new call. Replaced by a Join button once the new call is established.</td>
</tr>
<tr>
<td>📺</td>
<td>Transfers all held calls to the network audio conference server where an audio conference call is created.</td>
</tr>
<tr>
<td>📚</td>
<td>Transfers the call to another party.</td>
</tr>
<tr>
<td>🗝️</td>
<td>Displays the integrated dial pad. Send digits to the other party by selecting one or more of the dial pad digits.</td>
</tr>
<tr>
<td>🎥</td>
<td>Stops video on a call. However, the voice call can still remain active.</td>
</tr>
</tbody>
</table>
## Conversation window – Voice mail control buttons

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Icon]</td>
<td>Ends the voice mail call.</td>
</tr>
<tr>
<td>![Icon]</td>
<td>Holds/retrieves the voice mail call.</td>
</tr>
<tr>
<td>![Icon]</td>
<td>Sends the reply command digit(s) to the voice mail server.</td>
</tr>
<tr>
<td>![Icon]</td>
<td>Sends the call back command digit(s) to the voice mail server.</td>
</tr>
<tr>
<td>![Icon]</td>
<td>Sends your pre-defined key1 command digit(s) to the voice mail server.</td>
</tr>
<tr>
<td>![Icon]</td>
<td>Sends the previous message command digit(s) to the voice mail server.</td>
</tr>
<tr>
<td>![Icon]</td>
<td>Sends the play command digit(s) to the voice mail server.</td>
</tr>
<tr>
<td>![Icon]</td>
<td>Sends the next message command digit(s) to the voice mail server.</td>
</tr>
<tr>
<td>![Icon]</td>
<td>Sends the delete message command digit(s) to the voice mail server.</td>
</tr>
<tr>
<td>![Icon]</td>
<td>Sends your pre-defined key2 command digit(s) to the voice mail server.</td>
</tr>
<tr>
<td>![Icon]</td>
<td>Displays the integrated dial pad. Send digits to the voice mail server by selecting one or more of the dial pad digits.</td>
</tr>
</tbody>
</table>
### Conversation window – Sharing buttons

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Icon]</td>
<td>Displays a file dialog window that allows you to select a file to send to the remote party.</td>
</tr>
<tr>
<td>![Icon]</td>
<td>Displays the Whiteboard sharing application that allows you to share a common whiteboard with the remote party.</td>
</tr>
<tr>
<td>![Icon]</td>
<td>Sends the contents of your system clipboard to the remote party.</td>
</tr>
<tr>
<td>![Icon]</td>
<td>Displays a <strong>Web Push</strong> dialog that allows you to send a web page to the remote party.</td>
</tr>
</tbody>
</table>

### Conversation window – Instant Message buttons

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Icon]</td>
<td>Displays a file dialog window that allows you to select a file to send to the remote party.</td>
</tr>
<tr>
<td>![Icon]</td>
<td>Selects whether or not a timestamp should be displayed with messages in the instant message display area.</td>
</tr>
<tr>
<td>![Icon]</td>
<td>Prints your instant message display area.</td>
</tr>
<tr>
<td>![Icon]</td>
<td>Set attributes of your instant message text such as: color, weight, slant, and underline.</td>
</tr>
<tr>
<td>![Icon]</td>
<td>Erases the instant message display area.</td>
</tr>
<tr>
<td>![Icon]</td>
<td>Inserts an emoticon into your instant message text.</td>
</tr>
<tr>
<td>Button Image</td>
<td>Description</td>
</tr>
<tr>
<td>--------------</td>
<td>-------------</td>
</tr>
<tr>
<td><img src="image" alt="Chat Room" /></td>
<td>Enables you to create or join a chat room.</td>
</tr>
<tr>
<td><img src="image" alt="Send" /></td>
<td>Sends your instant message to the remote party.</td>
</tr>
</tbody>
</table>
106  Button references
Appendix B
Hardware notes

Topics in this section include:

- Compatible video cameras
- Compatibility with the client application

Compatible video cameras

The Multimedia PC Client requires video cameras that capture video in RGB-24 or I420 video format, and the vast majority of USB 1.x web cameras meet these requirements.

Note: Nortel can make no recommendation or statement of compatibility about which cameras work with the Multimedia PC Client on an individual user’s PC. There are too many issues out of Nortel’s control and influence for any concrete recommendations to be made.

Issues that may influence the operation of a camera are

- hardware revision of the CPU, CPU chipset, and motherboard
- software revision of CPU chipset and motherboard device drivers
- release and revision of the Windows operating system
- hardware revision of the camera
- software revision of the camera drivers
- the presence of other user-installed devices, USB or otherwise, which were previously installed on the user’s PC. Other devices may cause issues regardless of whether they are still present or not.
- the installation of other software packages on the user’s PC
Compatibility with the client application

The responsibility of ensuring compatibility of the camera with the Multimedia PC Client application is critical. Compatibility is usually indicated by successfully installing the camera, seeing the camera recognized by the client application, and proper behavior of the Multimedia PC Client application during and after several video telephony phone calls.

The following guidelines are recommended:

- Evaluate the camera in person before purchasing.
- If multiple computers with different versions of the Windows operating system are going to be used with the camera, evaluate the camera on all operating systems before purchasing.
- If multiple computers with different hardware configurations are going to be used with the camera, evaluate the camera on all hardware configurations before purchasing.
- Before installing a camera on a computer, always visit the camera vendor's web site for updated camera drivers, and use the updated drivers if available.
- Do not purchase USB cameras for use on computers with the Windows NT OS. Windows NT does not support USB devices.
Index

A
acronyms 4
auto-launch Multimedia PC Client 29

B
buttons
  active call 102
  incoming calls 101
  instant messaging 104
  main buttons 37
  sharing 104
  voice mail call 103

C
call control panel
  active call 60
calling
  answering calls 60
  ending calls 60
configurations
  Converged Multimedia Client 7
  Multimedia Client Set 21
  Multimedia PC Client 21
conventions, text 4

H
Help 5
help 48

I
installation 24

instant messages
  sending 96
interface
  Converged PC Client GUI 33
  main buttons 37
  main menu 36
  Multimedia PC Client GUI 33
  system tray icon 40
  understanding 33

L
launching the Multimedia PC Client 25

P
proxy server
  introduction 16

R
requirements
  minimum 23
  optional 24
  recommended 23

S
start up 25
system tray icon 40

T
text conventions 4
V

video
  cameras 101, 107
voice mail
  message waiting indicator 98
  using voice mail 97

W

wizards
  configuration 25